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Introduction   

Overview  
  

This installation guide describes the steps required to install BoardModeler Lite on your 

computer.  It also contains some important information on configuring the software, so please 

make sure you read this document completely before installing the software.   Please note that 

the dialogs may look slightly different to the images shown in this document depending on the 

version of the Windows operating system you are using.  

  

Trademarks  
• CADSTAR, CPA, BoardModeler Lite, ZUKEN logo and the CI mark are registered 

trademarks of ZUKEN, Inc.  

• OpenGL® API is the registered trademark of Silicon Graphics, Inc. in the United States, 

SGI Japan, Ltd in Japan, and/or other countries worldwide.  

• DirectX®, Direct3D®, MSXML, WOW64, and the Windows® are trademarks of Microsoft 

Corporation in the United States, other countries, or both.  

• HOOPS is a registered mark or trademark of TechSoft 3D, LLC or its subsidiaries in the 

United States and in other countries.  

• FLEXnet Publisher is a trademark or registered trademark of Flexera Software Inc.  

  

All other company or product names are trademarks or registered trademarks of their respective 

owners.  

  

Pre-requisites  
  

This installation guide assumes that you have already obtained the software installer by 

downloading it from the ZGS BoardModeler Lite Download Page.  You should have a file called 

‘BoardModelerLite.exe’ in a folder on your computer.  

  

  

PLEASE NOTE   

The BoardModeler Lite software must be installed by a user with ‘Administrator’ 

privileges (access rights) on the computer which the software will be installed on.  

  

  

Note that it is only necessary to have ‘Local Administrator’ privileges on this computer – the 

installation does not need to be done by a ‘Domain Administrator’.  
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Conventions and Terminology Used In This Document  
  

The following conventions and terminology are used throughout this document:  

  

• Commands, menu options or user interface operations are shown using bold italic 

text, for example, Tools / Options  

  

• Names of file system objects (file paths, file names, folder names etc.) are shown in 

italic  

text surrounded by single quotes, for example, ‘C:\BML Training\BM\_Project’   

  
• Throughout this guide, the ‘BoardModeler Lite’ application name is usually 

abbreviated to ‘BML’.  

  

  

Software Versions Covered By This Guide  
  

This installation guide covers the following software:  

  

 •  BoardModeler Lite 17.1  

  

  

  

Restrictions and Limitations  
  

Please note that BoardModeler Lite does not support UNC paths (e.g. \\server-name\folder-

path).  Please ensure that any remote network shared resources are accessed through a 

network drive (e.g. D:\folder-path).  

  

  

© 2023 ZUKEN Incorporated  
  

◼  Unauthorized reproduction of any portion of this document is prohibited.  

◼  The information in this document may be changed in the future without notice, for the purpose of 

improvement or enhancement.  

◼  While Zuken Inc. has taken every care in the preparation of this manual it is not possible to guarantee 

that there are no inaccuracies, ambiguities or omissions herein. Zuken Inc. will correct or clarify, as 

applicable, any inaccuracies, ambiguities and omissions which are brought to its attention but  
neither Zuken Inc. nor its distributors can accept any responsibility for any loss or damage of 

whatsoever nature and howsoever caused which might result either directly or indirectly from any 

such inaccuracies, ambiguities or omissions.  
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System Requirements for BoardModeler Lite  

This section describes the environment required to install BoardModeler Lite and gives information 

regarding  

  

Item  Requirement  

CPU  2.0 GHz or higher (3GHz or higher is recommended)  

Physical  

Memory  
1GB or higher (2GB or higher is recommended)  

HDD  500MB of free disk space or more (10GB or more is recommended)  

Graphics  
Graphics card supporting the OpenGL(R) API or DirectX 9.0c or later. 

(Conforming to the specification of HOOPS by the Tech Soft 3D, LLC)  

Other  

Information  

TCP/IP Always-Connected Environment (when using a network license) 

MSXML Version 4.0  

  

  

Graphics Cards Available To Run BoardModeler Lite  
  

BoardModeler Lite makes use of the HOOPS Technology (from Tech Soft 3D, LLC) as the graphics 

engine to represent the 3D models. The HOOPS Technology supports many graphics card provided 

by a range of hardware vendors, but it is possible that in some circumstances there could be cases 

where the graphics cannot be successfully displayed. In such a case  

BoardModeler Lite will display a warning message.  For example, BoardModeler Lite will be shut 

down after the "HOOPS Error" as shown below or a Windows memory addressing error occurs.  
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(Note: The content of the error message shown above is just an example.)  

  

If these warnings happen frequently, the following procedures may be tried to help avoid them.  

  

◼ Upgrade the Device Driver of the Graphics Card to the Latest Version.  

Please contact the Graphics Card vendor for specific instructions on how to obtain the latest driver.  

  

◼ Change the Type of Graphics Driver To "Direct3D".  

Select the Tools / Options menu option to display the BoardModeler Options dialog. Then 

select the Graphics tab, and choose the "Direct3D" from the Driver type combo box. Then 

click the Apply button.  

  

If the above steps fail to solve the problem then change the Windows configuration.  Note, the 

following change will cause a slight decrease in the graphics performace.  

  

◼ Turning off the Hardware Acceleration.  

Open Display from the Control Panel and select the Advance settings. Select the  

Troubleshoot tab and move the Hardware Acceleration slider to ‘None’.  

 

  

If the symptom does not improve, it is possibly due to an 

incompatibility between the graphics card and HOOPS.  In this 

case the only solution may be to use a different graphics card.  
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Integration with CADSTAR  

BoardModeler Lite may be launched either directly from within the CADSTAR Design Editor 

application or from the Windows ‘Start’ menu as required.  

  

Launch BoardModeler Lite from within CADSTAR Design Editor  

  

◼ Select the Tools - BoardModeler… menu option in Design Editor after first opening the 

required PCB design. The 3D representation of the PCB design is created and 

automatically opened in BoardModeler Lite.  

  

Launch BoardModeler Lite separately from the Windows ‘Start’ Menu  

  

◼ In this case, a CADSTAR PCB Archive format (CPA) file must first be exported from 

CADSTAR, using the File – Export menu option in Design Editor.  For use with 

BoardModeler Lite, it is necessary to output the appropriate version of CPA during the 

export process. For BoardModeler Lite 12.1 please select "Revision 20 format, 

CADSTAR 18.0 ", using the ‘Options…’ button on the Export dialog.  
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Installing BoardModeler Lite  

This section describes how to install BoardModeler Lite as a new installation.  

  

The installer supplied with the latest version of BoardModeler Lite can be used to update an existing 

software installation (version 6.0 or later) on your computer. There is no longer any need to manually 

uninstall the existing software first. However, if your current installation is BML version 5.0 or earlier, then 

you will still need to manually uninstall it before installing the new version.  

  

To install BoardModeler Lite on your computer, perform the following steps  

  

1. Navigate to the folder where you have 

downloaded the BML installer (‘BoardModelerLite.exe’) 

and double-click the file.  

  

Select Next> to start the installation.  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

2. Accept the terms of the license agreement then 

select Next> to continue with the installation.  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  



For more information visit   www.zuken.com/cadstar   

  9  

3. If you do not wish to install BML into the default 

location ‘C:\Program Files(x86)\Zuken\BoardModeler’ 

then select the Change button from the dialog to 

specify a different ‘Destination Folder’ for the 

software.  

  

Please note that it is not necessary to install the BML 

software inside the CADSTAR install directory.  (This 

was a requirement for the CADSTAR 3D product 

only).  You may install the BML software in a location 

of your choice.  

  

Once you have set the Destination Folder to the 

required location, select the Next> button.  

  

At this point the installer will check for disk space and 

memory resources on your computer.  You will be 

warned if this is not adequate.  

  

  

  

4. To install BML and the ‘Create Part Model’ (3D 

model wizard) function, select Complete and press 

the Next> button, which displays the ‘Document 

Root Folder’ dialog.  

  

But if the ‘Create Part Model’ (3D model wizard) 

function is not required, select Custom and press 

the Next> button which displays the ‘Custom Setup’ 

dialog.  
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5. From this Custom Setup dialog, you can 

choose whether or not to install the ‘Create Part 

Model’ (3D model wizard) functionality.  Select the 

icon next to the text ‘Create Part Model’ to select 

whether or not to install this functionallity, then press 

the Next> button to continue with the installation.  

  

  

  

  

  

  

  

  

 

 

 

 

6. The design data used by BML is stored in a 

defined folder structure in the file system on disk.  

The next dialog displayed allows you to set the 

location of the ‘Document Root’ folder for BML.  This 

is the main folder that, by default, contains all design 

and library data relating to BML.  

  

When this location is defined, four sub-folders will be 

automatically created (called _Project, _Library, 

_Interface and _Resource) inside a folder called ‘BM’ 

in the Document Root folder, to hold all the 

associated data.  

  

The default location for the Document Root folder set 

during the installation is ‘C:\DOCUMENT’.  However, 

you may change this path to be a different one of 

your choice.  Make sure the directory path chosen 

has ‘write’ access permission for the user(s) who 

will use BML.  
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7. In the example shown here, the location for the 

Document Root folder has been changed to match 

the default location of the training data which is used 

by the BML Tutorial.    

  

This location can also be changed later using the Project  

tab of the Tools / Options menu in BML.    

  

Once you have set the path to the required value, 

select the Next> button from the dialog.  

  

  

  

  

  

  

   

  

8. The next stage of the installation allows you to 

set up the licensing details for BML.  

  

In the case of a node-locked license (using a USB 

dongle), you need to enter the full path to your license 

file in the text entry box on the dialog.  The BML 

license should be included in your standard 

CADSTAR license file and by default, this will be a  

file called ‘license.dat’ which is located inside the  

CADSTAR ‘Programs’ folder (for example 

‘C:\Program Files(x86)\Zuken\CADSTAR 

15.0\Programs\license.dat’).  

  

 

 

 

If you have a network license server, then in the text entry box specify the location of the server in the 

form ‘port@host’ (e.g. ‘1700@ServerName’).  This information should be the same as that already used 

by CADSTAR and you can get this information from the System tab of the Tools / Options dialog in the 

CADSTAR application.  This is shown in the image below.  If in doubt, ask the person who administers 

the network licensing set-up for your installation.   
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Once you have filled in the required information, 

select the Next> button to continue with the 

installation.  

  

9. The next screen of the installer presents of 

summary of all the settings you have specified.  If 

there are any mistakes, select the Back> button to 

return to the previous steps and correct the 

settings.  

  

If the settings are correct, select the Next> button 

to confirm that the installation should proceed.  
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10. The software will then be installed and 

configured.  A green ‘progress bar’ will give an 

indication of activity as the installation progresses.  

  

If you need to stop the installation before it is 

complete, press the Cancel button.  

  

  

  

  

  

  

  

  

  

 

 

 

 

11. Once the software has been successfully 

installed, the screen shown on the left will be 

displayed.  

  

Select Finish to exit from the installer.  

  

The BML software should now be ready to use.  
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Installing BoardModeler Lite (Remote Installation)  

This section describes how to perform a remote network install of BoardModeler Lite.  

  

Please note that the remote network install is only available for new installation (not update installations).  

.  

The following command line can be used to remotely perform a full install of BML (including the ‘Create  

Part Model’ functionality).  Replace the text inside the square brackets ([ and ]) with the appropriate folder 

pathnames for your system.  

  

[Installer-path]/BoardModlerLite.exe /s /v”/qn INSTALLDIR=[Target- 

Installation-Folder] BM_DOCROOT=[Document-Root-Folder]”  

  

(Please note that the whole command above should be typed on the same line – the line-break is only as a 

result of the document formatting).  

  

To install BML without the ‘Create Part Model’ functionality, add the directive “INSTALLLEVEL=10” to the 

command line as follows:  

  

[Installer-path]/BoardModlerLite.exe /s /v”/qn INSTALLDIR=[TargetInstallation-

Folder] BM_DOCROOT=[Document-Root-Folder] INSTALLLEVEL=10”  

  

By installing BML via the command line you are agreeing to the terms of the licensing agreement.  
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Uninstalling BoardModeler Lite  

This section describes how to remove BoardModeler Lite from your computer.  

  

Before starting the process of uninstalling, please make sure that BML is not running.  

  

To uninstall, open the control panel by clicking the [Settings] - [Control Panel] from the [Start] menu, and 

then double-click the [Programs and Features].  

  

Select "BoardModeler Lite" from the [Currently installed programs] list, and click the [Uninstall] button.  

  

The confirmation dialog box appears, so click the [Yes] button to uninstall the program.  

  

Click the [OK] button to complete the process.  

  

  

 

Any data located under the working folder (Document Root Folder), such as the BML project data, part 

shapes located under the library folder, and the configuration files (in XML), will be retained after 

completing the uninstallation.  
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Updating the paths for the BML folders  

If you have Administrator privileges on your computer, then you can change the Document root, Project 

root and Library root folder paths at any time within BML, on the Project tab of the Tools / Option dialog. 

(The only restriction to note is that you must make this configuration change when there is no project data 

loaded in BML).    

  

Please remember, when you do change the Document root folder, make sure that the directory path 

chosen has ‘write’ access permission for the user(s) who will use BML.  

  

If you do not have Administrator privilege, then you will only be able to change all these paths if you select 

the Private option on the Project tab of the Tools / Options dialog.  To change these paths, perform the 

following steps:  

  

1. Launch BML (either from the Tools menu within 

CADSTAR Design Editor or from the Windows Start 

menu).  Do not load any project data, but open the 

Tools / Options dialog and ensure the Project tab is 

displayed.  

  

Select the ‘Private’ option at the top of the dialog.  

  

You will then see that it is possible to change the 

Document root, Project root and Library root folder 

paths.  

  

Make any required changes here (the paths chosen for 

Project and Library folders do not need to be under the 

Document root folder) and select the Apply button to 

confirm the changes.  

  

Please note that even if you do change the location of 

the Project root and Library root folders, BML will still 

write some files to the Document root folder too.  

Therefore it is important to always have ‘write’ access 

permission to this folder for the normal users of BML.  
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Sentinel Key (Dongle) Drivers  

  

If you are using a hardware key (dongle) with a node-locked license on your computer, in order to run BML 

successfully you must ensure that you have at least version 7.6.9 (or later) of the Sentinel drivers installed.  

You can check which version of the drivers you have installed in the Add or Remove Programs dialog in the 

Windows Control Panel.  

  

Open the Add or Remove Programs dialog and find the entry for the Sentinel driver.    

  

  
  

The dialog which will then be displayed will show the version which is currently installed.   If you 

need to install new drivers, you can find the correct ones on the CADSTAR installation CD.  
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Using the CADSTAR Self-Teach Data with BML  

Whenever a PCB design is transferred from CADSTAR Design Editor to BML, a temporary CPA file is generated 

in the same folder where the CADSTAR PCB file exists.  It is this file that BML imports in order to generate the 

3D view of the design.  

  

It is therefore important that the user running the CADSTAR and BML software has the necessary ‘write’ access 

permission to create new files in the folder where the CADSTAR PCB file is located.  If this is not the case, then 

the transfer to BML will fail (because the CPA file will not be generated).  

  

So, if you intend to use the CADSTAR Self Teach designs in combination with BML, please make sure that 

you copy the Self Teach folder into a location that has write permission for the user of CADSTAR and BML.  

  


